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Аннотация
Программа AutoCAD уже многие годы является одним из

наиболее мощных и широко распространенных инструментов
проектирования. Данная книга представляет собой превосходное
практическое руководство по AutoCAD 2010. Она предназначена
для всех, кто хочет освоить работу с этой программой и научиться
чертить на компьютере. Вы найдете описания всех стадий работы
– от начальной настройки параметров чертежа до вывода его на
печать. Кроме того, здесь рассмотрены специальные возможности
и технологии AutoCAD 2010.

Видеокурс прилагается только к печатному изданию
книги.
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Андрей
Александрович Орлов

AutoCAD 2010
 

Введение
 

Книга, которую вы держите в руках, посвящена програм-
ме AutoCAD 2010 – это уже 23-я версия данного пакета.
За долгие годы развития продукт компании Autodesk транс-
формировался из простого инструмента, способного лишь
заменить собой кульман, в программу, пригодную не толь-
ко для формирования двухмерных чертежей, но и для созда-
ния реалистичных трехмерных моделей. Фактически на дан-
ный момент AutoCAD 2010 является самой мощной систе-
мой автоматизированного проектирования (САПР), работа-
ющей на персональном компьютере.

Данный видеосамоучитель, ориентированный в основном
на начинающих пользователей, послужит вам путеводителем
в захватывающем мире AutoCAD. Книга снабжена большим
количеством практических примеров, а на компакт-диске
находятся видеоуроки, поэтому если вы обладаете хотя бы
небольшими навыками работы на компьютере, то понять
основные приемы работы с программой сможете довольно



 
 
 

быстро. В этом вам помогут начальные главы. Инструменты,
предлагаемые AutoCAD 2010, настолько разнообразны, что
умение их рационально использовать будет приходить посте-
пенно, с выполнением все новых и новых упражнений.

Значительная часть книги посвящена созданию трехмер-
ных чертежей. Научившись настраивать множество парамет-
ров, а также использовать разнообразные материалы и источ-
ники света, вы сможете довольно легко создавать трехмер-
ные реалистичные модели. Возможно, заключительные гла-
вы видеосамоучителя, как и описание новых возможностей
программы, будут полезны опытным пользователям.



 
 
 

 
От издательства

 
Ваши замечания, предложения и вопросы отправляйте по

адресу электронной почты dgurski@minsk.piter.com (изда-
тельство «Питер», компьютерная редакция).

Мы будем рады узнать ваше мнение!
На сайте издательства http://www.piter.com вы найдете

подробную информацию о наших книгах.

mailto:dgurski@minsk.piter.com
http://www.piter.com/


 
 
 

 
Глава 1

Знакомство с AutoCAD 2010
 

• Запуск программы
• Интерфейс программы
• Установки файлов чертежей
• Работа со справочной системой AutoCAD
• Резюме

Программа AutoCAD уже многие годы является одним
из наиболее мощных и широко распространенных инстру-
ментов проектирования. С выходом каждой новой версии
возможности приложения становятся все шире, элементы
управления модернизируются, появляются новые. Если вы
новичок в области автоматизированного черчения и не об-
ладаете опытом работы с AutoCAD, то, прежде чем присту-
пить к работе, вам необходимо ознакомиться с интерфейсом
программы, а также с основными принципами работы в ней.
Из данной главы вы узнаете, как запускать AutoCAD 2010,
познакомитесь с ее интерфейсом, а также научитесь пользо-
ваться справочной системой приложения.



 
 
 

 
Запуск программы

 
Как и любое приложение, разработанное для операцион-

ной системы Windows, программу AutoCAD можно запу-
стить несколькими способами. Рассмотрим наиболее рас-
пространенные из них.

•  Использование меню Пуск. Для запуска программы
нужно выполнить команду Пуск → Все программы →
Autodesk → AutoCAD 2010 → AutoCAD 2010 – English.

• Использование ярлыка программы на Рабочем столе.
Для запуска приложения достаточно найти на Рабочем сто-
ле его ярлык и дважды щелкнуть на нем.

• Если вы хотите не просто запустить программу, а от-
крыть определенный файл чертежа, необходимо открыть
Проводник или любой другой файловый менеджер, с его
помощью найти нужный вам файл и запустить его. В резуль-
тате загрузится AutoCAD и откроется требуемый файл, а ес-
ли вы уже запустили программу ранее, то просто откроется
нужный файл.

• По умолчанию программа AutoCAD не создает ярлык
на панели быстрого доступа, однако вы можете сделать это,
перетащив туда ярлык с Рабочего стола  или из меню Пуск
при нажатой клавише Ctrl. Запуск приложения с данной па-
нели удобен тем, что для этого не нужно открывать меню.
Кроме того, панель быстрого доступа всегда отображается



 
 
 

на экране, в то время как Рабочий стол может быть закрыт
запущенными приложениями.

Открыв AutoCAD любым удобным способом, вы увидите
на экране окно, в котором программа предлагает указать об-
ласть деятельности, наиболее приближенную к вашей рабо-
те: архитектура, гражданское строительство, производство и
т. д. (рис. 1.1).

Рис. 1.1. Окно мастера настройки интерфейса

В зависимости от выбранного варианта автоматически на-
страивается интерфейс программы. В результате инструмен-
ты, которые, по мнению разработчиков AutoCAD, больше
всего подходят для заданного вида деятельности, будут под



 
 
 

рукой.
Чтобы открыть окно AutoCAD с параметрами по умолча-

нию, щелкните на кнопке Skip (Пропустить), а в следующем
окне – на кнопке Start AutoCAD 2010 (Запустить AutoCAD
2010). В будущем при необходимости вы сможете изменить
тип интерфейса в настройках программы.

После старта программы откроется окно New Features
Workshop (Семинар по новым возможностям) (рис. 1.2).

Рис. 1.2. Окно New Features Workshop (Семинар по но-
вым возможностям)

Если вы работали с предыдущими версиями AutoCAD,
то можете ознакомиться с новыми возможностями продукта



 
 
 

в окне справки. Если вы ранее не сталкивались с этой про-
граммой, просто откажитесь от просмотра семинара. Что-
бы данное окно не появлялось каждый раз при запуске
AutoCAD, установите переключатель в положение No, don't
show me this again (Больше не показывать). В дальнейшем
при необходимости вы сможете открыть это окно в любой
момент.

Нажав кнопку OK, вы увидите рабочее окно программы
AutoCAD 2010 (рис. 1.3). Возможно, на первый взгляд оно
покажется вам очень сложным и громоздким, однако на са-
мом деле интерфейс очень удобен и способен адаптировать-
ся под конкретные задачи.



 
 
 

Рис. 1.3. Рабочее окно AutoCAD 2010



 
 
 

 
Интерфейс программы

 
Окно программы AutoCAD состоит из нескольких частей,

каждая из которых выполняет определенные функции: ввод
команд, отображение необходимой при черчении информа-
ции и т. д. Некоторые инструменты взаимодополняют и даже
замещают друг друга.

Центральная область рабочего окна программы называет-
ся графическим экраном. В ней выполняются все построе-
ния. На графическом экране указатель мыши приобретает
вид перекрестья и способен выполнять функции, используе-
мые в проектировании: привязку к объектам, задание коор-
динат и направления. При выходе за границы графического
экрана указатель приобретает привычный вид.

В верхней части окна находится лента с вкладками, на
которых расположены кнопки команд (см. рис. 1.3). Она за-
менила пункты меню, используемые в предыдущих версиях
программы. Для пользователей, предпочитающих прежний
вид окна, предусмотрена возможность переключения в ре-
жим, называемый классическим.

Рассмотрим ленту с вкладками, предназначенными для
рисования двухмерных объектов (видоизмененная лента для
создания трехмерных объектов описана в главе 9).

• Home (Основная) – здесь собраны основные средства,
используемые при работе с чертежами. Данная вкладка со-



 
 
 

держит следующие группы команд.
· Draw (Черчение)  – позволяет создавать графические

примитивы, наносить штриховку, создавать области или по-
лилинии из замкнутых элементов, различные маскирующие
объекты и др.

· Modify (Редактирование) – содержит инструменты для
такого преобразования объектов, как масштабирование,
удлинение, поворот, выравнивание и др., а также для редак-
тирования штриховки, сплайна и других объектов.

· Annotation (Аннотационные объекты) – содержит ин-
струменты для создания текста и таблиц, а также для нане-
сения размеров.

· Layers (Слои) – позволяет работать со слоями.
· Block (Блок) – содержит инструменты для работы с бло-

ками.
· Properties (Свойства) – позволяет управлять свойствами

объектов.
· Utilities (Утилиты) – содержит инструменты измерения,

быстрого выделения и подсчета.
· Clipboard (Буфер обмена) – дает возможность работать

с буфером обмена (копировать, вырезать, вставлять фраг-
менты и т. д.).

• Insert (Вставка)  – содержит инструменты для работы
с блоками и связями. На вкладке присутствуют следующие
группы команд.

· Reference (Связи) – предназначена для управления свя-



 
 
 

зями.
· Block (Блок) – служит для создания, вставки и редакти-

рования блоков.
· Attributes (Атрибуты) – позволяет создавать и редакти-

ровать атрибуты данных, находящихся в блоках.
· Import (Импорт)  – используется для импорта файлов

других форматов.
· Data (Данные) – содержит инструменты для работы с об-

новляемыми полями, объектами OLE, гиперссылками и дру-
гими объектами.

· Linking & Extraction (Связывание и распаковка) – со-
держит команды для работы со связями.

· Content (Содержимое)  – позволяет открыть палит-
ру DesignCenter (Центр управления), с помощью которой
удобно работать с проектом. Кроме того, в данной группе
расположена строка поиска, используя которую можно ис-
кать уже готовые элементы дизайна, находящиеся на сайте
http://seek.autodesk.com.

• Annotate (Аннотация) – здесь собраны инструменты для
создания текстовых надписей в документе. На этой вкладке
расположены такие группы команд.

· Text (Текст) – содержит инструменты для работы с тек-
стом (изменения стиля, размера шрифта и др.).

· Dimensions (Размеры) – предназначена для проставле-
ния размеров.

· Leaders (Выноски) – позволяет создавать и редактиро-

http://seek.autodesk.com/


 
 
 

вать выноски.
· Tables (Таблицы) – содержит инструменты для работы

с таблицами.
· Markup (Выделение) – содержит инструменты для со-

здания областей выделения.
· Annotation Scaling (Масштабирование аннотационных

объектов) – используется для изменения масштаба  аннота-
ционных объектов. Аннотационными в AutoCAD называ-
ют различные пояснительные объекты – размеры, выноски,
текст и т. д.

• Parametric (Параметрические)  – включает в себя ин-
струменты для параметрического черчения, позволяющие
работать с геометрическими и размерными ограничениями.
При использовании таких ограничений заданные соотноше-
ния между объектами остаются, даже если сами объекты из-
меняются. Данная вкладка содержит следующие группы ко-
манд.

· Geometric (Геометрические) – предназначена для рабо-
ты с геометрическими ограничениями.

· Dimensional (Размерные) – позволяет использовать раз-
мерные ограничения.

· Manage (Управление)  – дает возможность управлять
ограничениями (удалять, переименовывать, задавать им
числовые значения, формулы и т. д.).

• View (Отображение) – позволяет управлять отображе-
нием объектов на экране. Рассмотрим некоторые группы ко-



 
 
 

манд, которые присутствуют на этой вкладке.
· Navigate (Навигация)  – включает в себя инструмен-

ты для навигации по документу: прокрутку, увеличение и
уменьшение масштаба и т. д.

· Views (Виды) – позволяет выбрать наиболее удобный в
данный момент вид отображения объекта. Пиктограммы на-
глядно показывают назначение каждой команды.

· Coordinates (Координаты) – дает возможность указать
подходящую систему координат.

· Viewports (Видовые экраны) – позволяет создавать и ре-
дактировать плавающие видовые экраны.

· Palettes (Палитры) – предоставляет быстрый доступ к
различным палитрам, которые дают возможность управлять
свойствами объектов, связями с другими файлами чертежей
и пометками, добавленными к документу; выполнять раз-
личные вычисления, публиковать подшивки листов, групп
листов или отдельных листов и т. д.

· Windows (Окна) – содержит команды, используемые при
работе с несколькими открытыми чертежами. С помощью
этой группы вы можете размещать окна документов в рабо-
чей области программы, а также фиксировать их положение.

• Manage (Управление) – содержит инструменты для из-
менения различных настроек программы, адаптации интер-
фейса приложения (рабочего пространства, панелей инстру-
ментов, меню и сочетаний клавиш) для решения конкретных
задач. На этой вкладке также находится группа команд для



 
 
 

работы с макросами, создаваемыми на языке программиро-
вания VBA.

• Output (Вывод) – здесь собраны группы команд для на-
стройки параметров предварительного просмотра докумен-
та перед печатью, вывода его на печать, публикации в Ин-
тернете и экспорта.

• Express Tools (Дополнительные инструменты) – содер-
жит дополнительные инструменты различных категорий, ко-
торые просты в использовании и охватывают широкий диа-
пазон функций программы AutoCAD, включая черчение,
выделение и изменение объектов. Однако следует учиты-
вать, что эти инструменты являются дополнительными и
компания Autodesk не гарантирует их корректной работы.

При выборе определенных объектов на ленте могут появ-
ляться дополнительные вкладки для работы с ними. Напри-
мер, если вы вставите в документ таблицу, на ленте появится
вкладка Text Editor (Редактор текста) с инструментами для
редактирования вводимого в таблицу текста.

По умолчанию на ленте расположены все основные вклад-
ки, а на них, в свою очередь, все группы команд. Чтобы
убрать вкладку с ленты, щелкните на ленте правой кноп-
кой мыши и в подменю Tabs (Вкладки) снимите флажок
возле названия вкладки, которую планируете удалить с лен-
ты. Если вы хотите убрать с вкладки какую-либо группу ко-
манд, щелкните правой кнопкой мыши на вкладке и в под-
меню Panels (Группы) снимите флажок рядом с названием



 
 
 

группы, которую необходимо скрыть. Аналогично действуй-
те, если хотите добавить вкладку или группу на ленту, одна-
ко в данном случае флажки придется устанавливать рядом с
нужным пунктом.

Любую вкладку можно извлечь с ленты, чтобы она пре-
вратилась в отдельную панель (рис. 1.4). Такая панель бу-
дет отображаться, даже если вы выберете другую вкладку, до
тех пор пока вы не нажмете на этой панели кнопку Return
Panels to Ribbon (Вернуть группы на ленту).

Рис. 1.4. Извлеченные с ленты вкладки

Чтобы скрыть ленту, нужно щелкнуть на кнопке с направ-
ленным вниз треугольником



 
 
 

которая находится справа от названий вкладок ленты.
При первом щелчке лента свернется до названий вкладок
и групп инструментов, при втором – полностью исчезнет с
экрана. Чтобы снова отобразить ленту, следует опять нажать
кнопку с треугольником.

Над лентой расположено меню приложения (кнопка с бук-
вой «А»

). В нем вы найдете пункты, которые заменяли ленту с
вкладками в предыдущих версиях AutoCAD, а также неко-
торые другие элементы.

Рядом с кнопкой вызова меню приложения находится  па-
нель быстрого доступа. По умолчанию на ней располагают-
ся кнопки часто используемых команд: New (Новый), Open
(Открыть), Save (Сохранить), Undo (Отмена), Redo (Восста-
новление) и Plot (Печать).

В новой версии программы панель быстрого доступа была
дополнена новыми возможностями, которые позволяют уда-
лять инструменты с панели, добавлять разделители, а также
отображать панель быстрого доступа над или под лентой.

Примечание
Вы можете самостоятельно добавить на



 
 
 

панель быстрого доступа необходимые элементы.
Для этого щелкните на панели правой кнопкой
мыши и выберите пункт Customize Quick
Access Toolbar (Настройка панели быстрого
доступа). Откроется окно Customize User
Interface (Настройка интерфейса пользователя),
в основной части которого по умолчанию
расположен полный список команд AutoCAD
2010. Чтобы быстрее найти нужную команду,
можете выбрать в раскрывающемся списке,
расположенном вверху, необходимую категорию.
Чтобы добавить команду на панель, щелкните
на нужной строке кнопкой мыши и, не отпуская
ее, перетащите на панель быстрого доступа.
Затем в окне Customize User Interface (Настройка
интерфейса пользователя) нажмите кнопку OK.

В левой нижней части окна программы отображаются
вкладки Model (Модель), Layout1 (Лист 1) и Layout2 (Лист
2) (рис.  1.5). По умолчанию активной является вкладка
Model (Модель), которая означает, что на экране отображе-
но двух– или трехмерное пространство модели. При щелчке
на какой-либо из вкладок Layout (Лист) (их количество мо-
жет быть любым) вы перейдете к пространству листа, о ра-
боте с которым будет рассказано в главе 8. Слева от вкладок
расположены кнопки перехода между ними.



 
 
 

Рис. 1.5. Вкладки переключения между пространствами
листов и модели

В левой нижней части графической области окна про-
граммы отображается указатель пользовательской систе-
мы координат (ПСК) (см. рис.  1.5) По умолчанию в про-
грамме AutoCAD используется МСК — мировая система
координат (World Coordinate System, WCS). Ее указатель
расположен в точке с координатами (0; 0; 0).

Справа и снизу от графической области могут находиться
полосы прокрутки, предназначенные для перемещения по
чертежу. По умолчанию полосы прокрутки не отображаются,
поэтому при первом запуске программы вы их не увидите.



 
 
 

Совет
Для отображения полос прокрутки на

экране перейдите на ленте на вкладку View
(Отображение) и в разделе Windows (Окна)
щелкните на кнопке

Будет вызвано окно Options (Параметры), на
вкладке Display (Экран) которого необходимо
установить флажок Display scroll bars in drawing
window (Отображение полос прокрутки в окне
чертежа) (рис. 1.6).



 
 
 

Рис.  1.6. Вкладка Display (Экран) диалогового окна
Options (Параметры)

В нижней части окна программы расположена  строка со-
стояния с набором кнопок для управления отображением
чертежа. Их мы рассмотрим далее, в соответствующем под-
разделе.

Программа AutoCAD позволяет пользователю самостоя-
тельно определить цвет различных элементов рабочего окна.
Для этого выполните следующие действия.



 
 
 

1. Щелкните на кнопке меню с буквой «А» в левом верх-
нем углу окна AutoCAD. Появится меню для выбора команд
управления программой.

2.  В правом нижнем углу данного меню щелкните на
кнопке Options (Параметры).

3. В открывшемся диалоговом окне перейдите на вкладку
Display (Экран) (см. рис. 1.6).

4. В области Window Elements (Элементы окна) щелкни-
те на кнопке Colors (Цвета).

5. В появившемся окне Drawing Window Colors (Цвета
окна чертежа) в списке Context (Контекст) выберите разно-
видность окна программы, в списке Inteface element (Эле-
мент интерфейса)  – элемент, а в раскрывающемся списке
Color (Цвет) – нужный вам цвет.

Так, например, чтобы изменить фон пространства модели
на белый, необходимо в списке Context (Контекст) выбрать
пункт 2D model space (Пространство двухмерной модели),
в списке Inteface element (Элемент интерфейса) – Uniform
background (Однородный фон), а в списке Color (Цвет) –
White (Белый). При этом в поле Preview (Предварительный
просмотр) цвет фона сменится на белый (рис. 1.7).



 
 
 

Рис. 1.7. Изменение фона пространства модели

6. Нажмите кнопку Apply & Close (Применить и закрыть)
для сохранения изменений и выхода из диалогового окна.

Чтобы перейти к классическому виду рабочего окна про-
граммы, щелкните на кнопке Workspace Switching (Пе-
реключение рабочего пространства), которая находится в



 
 
 

нижней части окна программы (на данной кнопке напи-
сано название текущего рабочего пространства, например
Initial Setup Workspace (Начальное установочное рабочее
пространство)), и выберите в появившемся списке строку
AutoCAD Classic (Классический AutoCAD). Окно програм-
мы отобразится в классическом виде, более привычном для
пользователей прежних версий (рис. 1.8).

Рис. 1.8. Классический вид окна программы AutoCAD

Познакомимся с ним подробнее. Строка меню включает
в себя множество пунктов для вызова различных команд и
открытия диалоговых окон.



 
 
 

• File (Файл). Здесь находятся команды обработки фай-
лов: создания, сохранения, восстановления. Кроме того, это
меню содержит команды, используемые для печати докумен-
тов.

• Edit (Правка). Пункты данного меню позволяют выпол-
нять стандартные для Windows операции работы с буфером
обмена (вырезать, скопировать, вставить), а также команды
специальной вставки, удаления, выделения и поиска.

• View (Вид). С помощью команд данного меню вы може-
те управлять отображением объектов на экране. Здесь рас-
положены такие подменю, как Zoom (Масштабирование),
Pan (Панорамирование) и др. В этом же меню находят-
ся команды регенерации чертежей. Кроме того, меню View
(Вид) содержит команду Toolbars (Панели инструментов),
при выборе которой на экране отображается диалоговое ок-
но Customize User Interface (Настройка интерфейса поль-
зователя). С помощью данного окна вы сможете создавать
собственные меню, панели инструментов, назначать сочета-
ния клавиш для быстрого вызова команд и окон, а также ре-
дактировать имеющиеся. Более подробно об этом диалого-
вом окне будет рассказано ниже.

• Insert (Вставка). Команды этого меню позволяют встав-
лять в поле чертежа блоки и объекты, созданные ранее в сто-
ронних приложениях, а также импортировать в AutoCAD
различные файлы.



 
 
 

• Format (Формат). Данное меню предназначено для вы-
зова диалоговых окон, помогающих определить множество
параметров черчения. Последняя команда – Rename (Пере-
именовать) – служит для переименования различных объек-
тов программы, таких как слои, материалы, блоки и др.

• Tools (Сервис). Здесь вы можете изменять различные на-
стройки программы, вызывать на экран вспомогательные ок-
на, а также загружать внешние приложения и управлять ими.
В этом же меню находится группа команд для работы с мак-
росами, создаваемыми на языке программирования VBA.

Подменю Workspaces (Рабочие пространства) предостав-
ляет доступ к рабочим пространствам программы. Оно слу-
жит для переключения между пространствами, а также для
их настройки и сохранения.

Палитры программы сгруппированы в отдельное подме-
ню – Palettes (Палитры). Рассмотрим его содержимое.

· Ribbon (Лента) – включает отображение ленты с инстру-
ментами.

· Properties (Свойства) – открывает палитру, позволяю-
щую управлять свойствами объектов.

· Layer (Слой) – вызывает палитру, содержащую команды
для работы со слоями.

· Tool Palettes (Инструментальные палитры) – открыва-
ет палитру, содержащую различные инструменты, такие как
блоки, образцы штриховок и т. д., в одном окне для упроще-
ния доступа к ним.



 
 
 

· QuickCalc (Быстрый подсчет) – вызывает палитру, поз-
воляющую выполнить различные вычисления (эту палитру
можно также вызвать сочетанием клавиш Ctrl+8).

· External References (Внешние связи) – открывает па-
литру, которая дает возможность управлять связями с дру-
гими файлами чертежей.

· Sheet Set Manager (Менеджер подшивок) – вызывает
палитру, служащую для публикации подшивок листов, групп
листов или отдельных листов.

· Markup Set Manager (Менеджер пометок) – открыва-
ет палитру, которая позволяет управлять пометками, добав-
ленными к документу.

· DesignCenter (Центр управления) – вызывает палитру, с
помощью которой можно управлять такими объектами чер-
тежей, как блоки, внешние ссылки или образцы штриховки.

Подменю Palettes (Палитры) также позволяет вызывать
различные палитры для работы с освещением, материалами
и визуализацией объектов. Их применение будет рассмотре-
но в главах, рассказывающих о работе с трехмерными тела-
ми. Последняя палитра – dbConnect (Связь с базами дан-
ных) – предназначена для работы с базами данных.

Далее в меню Tools (Сервис) находятся команды: Spelling
(Правописание), которая позволяет проверить орфографию
в выбранном пользователем тексте, Quick Select (Быстрый
выбор), служащая для быстрого создания групп объектов, и
Draw Order (Порядок следования), предоставляющая воз-



 
 
 

можность переносить объекты на заданный план.
Подменю New UCS (Новая ПСК) содержит команды для

создания новых ПСК (пользовательских систем координат)
с использованием различных методов, а также для редакти-
рования имеющихся систем. Команда Named UCS (Имено-
ванные ПСК) открывает диалоговое окно, отображающее со-
храненные пользовательские системы координат.

С помощью пункта Drafting Settings (Режимы рисова-
ния) можно устанавливать необходимые настройки режимов
рисования, а пункт Options (Параметры) (как говорилось ра-
нее) вызывает одноименное диалоговое окно, предназначен-
ное для настройки параметров программы.

• Draw (Черчение). Команды этого меню предназначены
для создания примитивных двух– и трехмерных объектов.

· Подменю Modeling (Моделирование) используется для
создания трехмерных объектов.

· Пункт Hatch (Штриховка) позволяет наносить штрихов-
ку в выбранных областях.

· Команда Boundary (Контур) служит для создания обла-
сти или полилинии из замкнутых объектов.

· С помощью пункта Wipeout (Маскировка) можно созда-
вать различные маскирующие объекты.

· Подменю Text (Текст) предназначено для создания од-
но– или многострочного текста.

• Dimension (Размер). С помощью команд данного меню
можно создавать размеры и выноски различных типов, таких



 
 
 

как Linear (Линейный), Aligned (Параллельный), Ordinate
(Ординатный). Здесь же расположены команды редактиро-
вания размерных надписей. Команда Multileader (Мульти-
выноска) служит для создания мультивыносок (которые за-
менили собой используемые в более ранних версиях про-
граммы выноски). Более подробно об этом мы поговорим в
главе 5, посвященной нанесению размеров.

• Modify (Редактирование). С помощью этого меню мож-
но выполнять такие преобразования объектов, как масшта-
бирование, удлинение, поворот и др.

Кроме того, здесь находятся команды редактирования та-
ких объектов, как штриховка, сплайн, текст и др., а также ко-
манды различных трехмерных операций и редактирования
трехмерных тел.

Подменю Annotative Object Scale (Масштаб аннотацион-
ных объектов) позволяет добавлять и удалять значения мас-
штаба аннотационных объектов.

• Parametric (Параметрические). Данное меню содержит
команды для работы с геометрическими и размерными огра-
ничениями.

• Window (Окно). Это меню включает в себя команды,
используемые при работе с несколькими открытыми черте-
жами, и служит для поддержки многодокументного режима
работы.

•  Help (Справка). В данном меню находятся разделы
справки, содержащие полную информацию, необходимую



 
 
 

для работы в AutoCAD. Справочные материалы отобража-
ются в отдельном окне и не мешают работе с программой.
Более подробно о справочной системе будет рассказано да-
лее.

•  Express (Дополнительные средства). Это меню содер-
жит дополнительные команды различных категорий и обла-
дает собственной системой справки (пункт Help (Справка)),
а также сборником ответов на наиболее часто задаваемые во-
просы (пункт Express Tools FAQ (Наиболее часто задавае-
мые вопросы по Express Tools)).

 
Панели инструментов

 
Панели инструментов являются графическим интерфей-

сом команд программы AutoCAD, то есть выполняют соот-
ветствующие им функции. О назначении кнопки вы можете
узнать, подведя к ней указатель мыши. При этом появится
всплывающая подсказка с кратким описанием кнопки. Если
для команды назначено сочетание клавиш, оно также будет
показано во всплывающей подсказке. На рис. 1.9 представ-
лена панель инструментов Standard (Стандартная) с указа-
телем мыши, подведенным к кнопке Save (Сохранить).



 
 
 

Рис. 1.9. Подсказки панели инструментов

Многие кнопки на панелях инструментов дублируют ко-
манды на ленте или в меню (если вы работаете с классиче-
ским интерфейсом программы). Вы можете выбрать более
удобный для себя способ вызова команды.

В правом нижнем углу некоторых кнопок имеется малень-
кая черная стрелка. Если какое-то время удерживать на ней
нажатой левую кнопку мыши, на экране появится меню с
дополнительными элементами. На рис. 1.10 показано меню
Zoom Window (Масштабирование окна) панели инструмен-
тов Standard (Стандартная).



 
 
 

Рис.  1.10. Меню дополнительных инструментов Zoom
Window (Масштабирование окна)

Панели инструментов могут быть закрепленными (в та-
ком состоянии они отображаются по умолчанию) и плава-
ющими. Название плавающей панели инструментов можно
увидеть в подсказке, появляющейся при наведении указате-
ля мыши на панель. Для закрытия плавающей панели ин-
струментов предназначена кнопка с крестиком, расположен-
ная в ее правой части. Кнопки плавающей панели инстру-



 
 
 

ментов могут располагаться как в один ряд, так и в несколь-
ко. Чтобы сделать панель плавающей, достаточно перета-
щить ее с помощью мыши на некоторое расстояние от края
графического экрана. На рис. 1.11 показана плавающая па-
нель инструментов Standard (Стандартная) с различным
расположением кнопок.

Рис.  1.11. Различные состояния панели инструментов
Standard (Стандартная)

Примечание
Если вы не хотите, чтобы панель инструментов

«приклеивалась» к  краю графической области,
при перемещении панели удерживайте нажатой
клавишу Ctrl.

Всего в AutoCAD 2010 имеется 44 панели инструментов.
Чтобы отобразить или скрыть какую-либо панель инстру-
ментов, щелкните на любой из них правой кнопкой мыши.
На экране появится меню, содержащее список доступных па-
нелей (рис. 1.12).



 
 
 



 
 
 

Рис. 1.12. Меню отображения/ скрытия панелей инстру-
ментов

Для отображения/скрытия любой панели выберите ее в
меню. В нижней части меню расположено подменю Lock
Location (Место фиксации), с помощью которого вы можете
блокировать положение панелей инструментов и палитр. На-
пример, чтобы отобразить панель инструментов View (Вид)
и блокировать ее, сделайте следующее.

1. Щелкните правой кнопкой мыши на любой панели ин-
струментов и выберите пункт View (Вид).

2.  С помощью мыши перетащите панель инструментов,
как показано на рис. 1.13.



 
 
 

Рис. 1.13. Перетаскивание панели инструментов

3. Щелкните правой кнопкой мыши на панели, в открыв-
шемся меню выполните команду закрепления плавающих
панелей инструментов: Lock Location → Floating Toolbars/
Panels (Место фиксации → Плавающие панели ин струмен-
тов/группы).

Панель будет блокирована, и вы не сможете перемещать
ее по рабочему окну. Для отмены блокирования снова вы-
полните эту же команду.

По умолчанию в рабочей области программы AutoCAD
2010 классического вида отображены восемь наиболее ис-



 
 
 

пользуемых панелей инструментов, присоединенных к верх-
ней, левой и правой сторонам графической области програм-
мы. Остановимся на двух наиболее часто используемых па-
нелях инструментов.

• Standard (Стандартная) (см. рис. 1.11) – содержит кноп-
ки, предназначенные для вызова базовых команд, таких как
создание, открытие, сохранение файла, просмотр проекта
перед печатью и вывод его на печать, операции с буфером
обмена, отмена и возврат действий. Кроме того, здесь рас-
положены команды вызова палитр программы.

• Workspaces (Рабочие пространства) (рис. 1.14) – служит
для переключения между рабочими пространствами про-
граммы AutoCAD 2010: 2D Drafting & Annotation (Двух-
мерное черчение и аннотирование), 3D Modeling (Трех-
мерное моделирование), AutoCAD Classic (Классический
AutoCAD) и Initial Setup Workspace (Начальное установоч-
ное рабочее пространство).



 
 
 

Рис.  1.14. Панель инструментов Workspaces (Рабочие
пространства)

Остальные панели мы рассмотрим по мере описания ра-
боты с программой. Сейчас же обратимся к основному сред-
ству работы с инструментами AutoCAD, а именно к инстру-
ментальной палитре, которая занимает правую часть рабо-
чего окна программы.

 
Инструментальная палитра

 
Чтобы вызвать инструментальную палитру, выполните

команду ленты View → Palettes → Tool Palettes (Вид →
Палитры → Инструментальные палитры). На инструмен-
тальной палитре содержатся кнопки вызова инструментов,



 
 
 

сгруппированные по их функциональному назначению на
множестве вкладок (рис. 1.15).



 
 
 



 
 
 

Рис. 1.15. Инструментальная палитра

Щелчок кнопкой мыши на значке открывает вкладку, со-
держащую набор кнопок для выбора инструментов. Рассмот-
рим вкладки, отображаемые на инструментальной палитре
по умолчанию.

• Draw (Черчение). Кнопки в верхней части вкладки поз-
воляют создавать различные примитивы: Line (Отрезок),
Construction Line (Прямая), Polyline (Полилиния), Polygon
(Многоугольник) и т. д. Кнопки в нижней ее части служат
для ввода более сложных объектов: блоков, рисунков и др.

• Leaders (Выноски). Содержит набор кнопок, позволяю-
щих создавать выноски.

• Command Tool Samples (Образцы командных инстру-
ментов). Включает в себя инструменты для управления вво-
дом команд.

• Tables (Таблицы). Здесь находятся инструменты для со-
здания таблиц разных типов – расписаний, легенд чертежей.

•  Hatches and Fills (Штриховки и заливки). Содержит
инструменты, позволяющие закрашивать поверхность чер-
тежа, создавая узоры, заливки и градиенты. На вкладке со-
держится множество доступных образцов узоров и заливок.

• Structural (Конструктивные). Здесь находятся инстру-
менты для черчения стандартных конструкций, например
балок различных сечений.

• Civil (Гражданские). На вкладке собраны образцы раз-



 
 
 

личных знаков, применяемых для привлечения внимания:
запреты, оповещения и обозначения.

•  Electrical (Электрические). Содержит обозначения,
применяемые при рисовании электротехнического оборудо-
вания: наборы выключателей, сигнальных ламп и др.

• Mechanical (Механические). Здесь собраны инструмен-
ты для рисования механических устройств: болтов, гаек,
подшипников и т. д.

• Architectural (Архитектурные). Содержит инструменты
для рисования дверей, окон и прочих конструкций, исполь-
зуемых в строительстве.

• Annotation (Аннотационные объекты). Здесь собраны
различные пояснительные обозначения, используемые на
чертежах: стрелки, указания и примечания.

• Constraints (Ограничения). На этой вкладке представ-
лены инструменты для работы с геометрическими и размер-
ными ограничениями.

• Modeling (Моделирование). Содержит сложные элемен-
ты, используемые при черчении геометрических объектов:
спирали, цилиндры, оси координат и т. д.

Как и все элементы пользовательского интерфейса про-
граммы AutoCAD, инструментальную палитру можно на-
строить в соответствии с вашими нуждами. Чтобы ука-
зать, какие вкладки должны отображаться, щелкните правой
кнопкой мыши на свободной части палитры, чтобы вызвать
контекстное меню. При выполнении команды Customize



 
 
 

Palettes (Настройка палитр) появляется диалоговое окно
Customize (Настройка), в котором можно сконфигуриро-
вать инструментальную палитру, добавить на нее новые
вкладки и содержащиеся на них инструменты.

 
Командная строка

 
Командная строка (рис. 1.16) расположена ниже графи-

ческой области программы и позволяет вводить команды с
клавиатуры. В ранних версиях AutoCAD она была основным
инструментом диалога пользователя и программы, однако с
выходом новых релизов значение данного элемента все боль-
ше снижается. Существенную роль в этом сыграло появле-
ние в AutoCAD 2006 динамического ввода, позволяющего
вводить команды в области рисования, рядом с графическим
курсором. Тем не менее командная строка выполняет опре-
деленные функции и все еще остается достаточно важным
элементом интерфейса. При работе вы периодически будете
ее использовать.

Рис. 1.16. Командная строка

Независимо от способа ввода команда отображается в ко-
мандной строке. Кроме того, здесь присутствуют все пара-
метры команды, а также подсказки. После ввода команды в



 
 
 

командной строке появится запрос на действие с доступны-
ми параметрами команды. Вы можете задать параметры, за-
пустить выполнение команды или прервать его, нажав кла-
вишу Esc.

Командная строка хранит историю введенных команд.
Однако, поскольку область команд занимает две строки,
просмотр истории затруднителен. Вы можете увеличить раз-
мер командной строки, но это уменьшит графическую об-
ласть, что очень неудобно. Для решения данной проблемы
в программе AutoCAD предусмотрено отображение области
команд в отдельном окне. Если вам нужно просмотреть ис-
торию команд, нажмите клавишу F2, и на экране появится
окно AutoCAD Text Window (Текстовое окно AutoCAD) с
необходимой информацией (рис. 1.17). Чтобы убрать его, на-
жмите еще раз клавишу F2.



 
 
 

Рис. 1.17. Диалоговое окно AutoCAD Text Window (Тек-
стовое окно AutoCAD)

 
Строка состояния

 
Как уже говорилось выше, в нижней части окна програм-

мы AutoCAD расположена строка состояния (рис. 1.18).

Рис. 1.18. Строка состояния

Она содержит текущие координаты указателя мыши, а
также кнопки включения/выключения режимов черчения.



 
 
 

Кратко рассмотрим назначение кнопок.

Snap Mode (Режим привязки) – включает/отключает ре-
жим шаговой привязки, то есть привязки к точкам сетки с
определенным шагом. Эту кнопку дублирует клавиша F9 на
клавиатуре.

Grid Display (Отображение сетки) – включает/отключает
отображение на экране сетки. Щелчок на этой кнопке рав-
нозначен нажатию клавиши F7.

Ortho Mode (Ортогональный режим) – включает/отклю-
чает ортогональный режим. При включенном режиме пе-
ремещение указателя мыши ограничено горизонтальным и
вертикальным направлениями. Эту кнопку дублирует клави-
ша F8.



 
 
 

Polar Tracking (Полярное отслеживание) – включает/вы-
ключает режим полярного отслеживания. Полярное отсле-
живание ограничивает перемещение указателя направлени-
ем под заданным углом, облегчая выбор точек, лежащих на
воображаемых линиях под одним из заданных полярных уг-
лов. Щелчок на этой кнопке соответствует нажатию клави-
ши F10.

Object Snap (Объектная привязка) – позволяет выбирать
различные точки объектов при работе с ними, облегчая по-
зиционирование графического курсора. Эту кнопку дубли-
рует клавиша F3.

Object Snap Tracking (Объектное отслеживание) – вклю-
чает/выключает режим объектного отслеживания, который
помогает вычерчивать объекты под определенными углами
или в определенных соотношениях с другими объектами.
При включенных режимах автоотслеживания специальные
временные линии помогают выполнять точные построения.
Щелчок на этой кнопке равнозначен нажатию клавиши F11.



 
 
 

Allow/Disallow Dynamic UCS (Включить/выключить ди-
намическую систему координат) – включает/отключает ре-
жим динамической системы координат, которая предназна-
чена для работы с трехмерными объектами и позволяет вре-
менно выровнять плоскость XY по какой-либо имеющейся
плоскости.

Dynamic Input (Динамический ввод) – включает/отклю-
чает режим динамического ввода, который позволяет вво-
дить команды и выбирать их параметры в области курсора,
без использования командной строки. Если динамический
ввод включен, сведения, отображаемые в подсказках рядом
с указателем мыши, динамически обновляются по мере его
перемещения. Когда команда активна, подсказки обеспечи-
вают место для ввода, осуществляемого пользователем.

Show/Hide Lineweight (Показать/скрыть толщину ли-
ний) – включает/выключает режим отображения линий в со-
ответствии с их толщиной.



 
 
 

Quick Properties (Краткие свойства) – включает/выклю-
чает отображение панели со свойствами выбранного объек-
та.

Model or Paper space (Пространство модели или бума-
ги) – позволяет переключаться между пространствами моде-
ли и листа.

Quick View Layouts (Быстрый просмотр листов) – отоб-
ражает сразу все листы чертежа в отдельных окнах неболь-
шого размера.

Quick View Drawings (Быстрый просмотр чертежей)
включает/выключает просмотр чертежей.



 
 
 

Pan (Панорамирование) – панорамирование рисунка.

Zoom (Масштабирование) плавное изменение масштаба
рисунка.

SteeringWheels (Управление колесиком) – включает ин-
струмент Wheel (Колесико) (рис. 1.19).



 
 
 

Рис. 1.19. Инструмент Wheel (Колесико)

ShowMotion (Показать движение) – вызывает набор ин-
струментов Motion (Движение).

Annotation Scale (Масштаб аннотационных объектов)
меню, вызываемое нажатием этой кнопки, позволяет уста-
новить текущее значение масштаба аннотаций. Любые анно-
тационные объекты, добавленные на чертеж, будут отобра-



 
 
 

жаться в масштабе, соответствующем указанному значению.

Annotation Visibility (Отображение аннотации) – изме-
няет значение системной переменной ANNOALLVISIBLE.
Когда ее значение равно 1, на экране отображаются все анно-
тационные объекты. Если переменной присвоить значение
0, будут видны лишь те объекты, которые поддерживаются
текущим значением аннотационного масштаба.

Automatically add scales to annotative objects when the
annotation scale changes (Автоматически обновлять анно-
тационные объекты при изменении масштаба) – регулирует
значение системной переменной ANNOAUTOSCALE и от-
вечает за обновление аннотационных объектов при измене-
нии аннотационного масштаба.

Workspace Switching (Изменение рабочей области) – вы-
зывает меню для выбора режима отображения рабочей об-
ласти.



 
 
 

кнопка для блокирования положения панелей инструмен-
тов и окон. Пример использования данной функции был
приведен выше.

Performance Tuner (Настройщик производительности) –
тестирует вашу видеокарту и выдает результаты в отдельном
окне.

Application Status Bar Menu (Меню содержимого стро-
ки состояния)  – в открываемом с помощью этой кнопки
меню задается отображение кнопок включения/выключения
режимов черчения в строке состояния (рис. 1.20).



 
 
 

Рис. 1.20. Контекстное меню настройки строки состояния

Clean Screen (Очистка экрана) – очищает экран. При ее



 
 
 

нажатии исчезают все панели инструментов – таким образом
увеличивается область графического экрана. Эта функция
полезна при работе на мониторах с небольшой диагональю.

 
Палитры

 
Палитры AutoCAD – это отдельные окна, предоставляю-

щие дополнительные функции (рис. 1.21). По сути, это те
же панели инструментов, позволяющие, однако, выполнять
более разнообразные действия и работающие в диалоговом
режиме.



 
 
 

Рис. 1.21. Палитра Sheet Set Manager (Менеджер подши-
вок)

Как и панели, палитры могут быть плавающими и при-
крепленными. В плавающем режиме у палитры появляет-



 
 
 

ся заголовок, содержащий название палитры и три кнопки.
Верхняя кнопка с крестиком служит для закрытия панели.
Расположенная далее кнопка со стрелками скрывает/восста-
навливает палитру. Эта функция позволяет палитре не зани-
мать лишнее место и при этом оставаться постоянно доступ-
ной. Нижняя кнопка открывает меню (рис. 1.22), с помощью
которого вы можете закрепить палитру у левого или право-
го края рабочей области, разрешить/запретить закрепление
и скрытие панели. Кроме этих пунктов, могут быть и другие,
характерные для конкретной палитры.

Рис. 1.22. Меню палитры Sheet Set Manager (Менеджер
подшивок)

Чтобы получить доступ к палитрам, выполните команду
ленты View → Palettes → Tool Palettes (Вид → Палитры →
Инструментальные палитры).



 
 
 

 
Настройка пользовательского

интерфейса
 

Программа AutoCAD предоставляет пользователю широ-
кие возможности адаптации интерфейса для решения кон-
кретных задач. Управлять настраиваемыми элементами ин-
терфейса, к которым относятся рабочее пространство, пане-
ли инструментов, меню и сочетания клавиш, можно с помо-
щью диалогового окна Customize User Interface (Настрой-
ка интерфейса пользователя) (рис. 1.23). Чтобы его открыть,
нажмите кнопку User Interface (Интерфейс пользователя)
на вкладке Manage (Управление) в группе Customization
(Настройка) ленты или выполните команду меню Tools →
Customize → Interface (Сервис → Настройка → Интер-
фейс). Вы также можете щелкнуть правой кнопкой мыши на
любой панели инструментов и в контекстном меню выбрать
пункт Customize (Настройка).



 
 
 

Рис. 1.23. Диалоговое окно Customize User Interface (На-
стройка интерфейса пользователя)

Окно открывается на вкладке Customize (Настройка), ко-
торая содержит четыре области.

• Customizations in All Files (Настройка всех файлов) –



 
 
 

здесь представлены элементы настраиваемого пользователь-
ского интерфейса, в которые можно вносить изменения. Вы
можете изменять все файлы интерфейса или выбрать ка-
кой-либо один из раскрывающегося списка, расположенного
в верхней части области (рис. 1.24).

Рис. 1.24. Список файлов настраиваемого пользователь-
ского интерфейса

• Command List (Список команд) – содержит полный пе-
речень команд AutoCAD 2010. Для упрощения поиска вы
можете выбрать в списке категорию, которой принадлежит
нужная вам команда.

•  Preview (Предварительный просмотр)  – отображает
внешний вид выделенного объекта. Здесь же можно изме-
нить вид значка какой-либо команды. Для этого выдели-
те команду в списке Command List (Список команд) и
в области Button Image (Значок кнопки) выберите один
из предложенных значков. Если вы хотите вручную нари-



 
 
 

совать значок, нажмите кнопку Edit (Изменить). На экра-
не отобразится диалоговое окно Button Editor (Редактор
кнопок) (рис. 1.25). Инструменты, предоставляемые редак-
тором, аналогичны возможностям графического редактора
Paint – стандартного инструмента операционной системы
Windows.

Рис. 1.25. Диалоговое окно Button Editor (Редактор кно-
пок)

• Properties (Свойства)  – позволяет изменять свойства
выделенных объектов. Например, вы можете изменить вид
кнопки, загрузив собственный графический файл.

Теперь, ознакомившись с основными элементами диало-
гового окна, создадим собственную панель инструментов и



 
 
 

добавим на нее кнопки.
1. В области Customizations in All Files (Настройка всех

файлов) найдите пункт Toolbars (Панели инструментов).
Щелкните на нем правой кнопкой мыши и выберите в по-
явившемся меню пункт New Toolbar (Создать панель ин-
струментов) (рис. 1.26).

Рис. 1.26. Создание новой панели инструментов



 
 
 

2. Введите название панели и определите ее свойства в
области Properties (Свойства).

· Раздел General (Общие) позволяет изменить название
и описание панели. Для этого щелкните кнопкой мыши на
любом пункте и введите нужное значение в правом столбце.

· В разделе Appearance (Вид) вы можете указать, будет
ли панель отображаться по умолчанию, задать ее ориента-
цию, координаты появления и количество строк. Например,
чтобы по умолчанию панель инструментов не отображалась
на экране, щелкните на пункте Default Display (Отображе-
ние по умолчанию). Справа появится кнопка со стрелочкой.
Щелкните на ней и в открывшемся списке выберите Do not
add to workspases (Не добавлять к рабочим пространствам).

3. Теперь следует добавить на панель команды. Для это-
го выберите необходимую команду в списке и с помощью
мыши перетяните ее в область Customizations in All Files
(Настройка всех файлов). Поместите указатель напротив со-
зданной вами панели инструментов (рис.  1.27). Отпустите
кнопку мыши – и команда будет добавлена на эту панель.



 
 
 

Рис. 1.27. Добавление команды на панель инструментов

4.  Нажмите кнопку OK для создания новой панели
(рис. 1.28).

Рис. 1.28. Новая панель инструментов



 
 
 

 
Установки файлов чертежей

 
Все чертежи, созданные в программе AutoCAD, хранятся

в файлах с расширением DWG. В таком файле содержится
полная информация о чертеже: всевозможные стили, пара-
метры, такие как единицы измерения, режимы черчения и
т. д. Формат DWG отличается небольшим временем сохра-
нения, особенно в случае, если это файлы с большим коли-
чеством аннотационных объектов.

По мере развития программы формат используемых фай-
лов также изменяется, поэтому чертежи, созданные в более
новых версиях AutoCAD, не могут быть открыты в более ста-
рых. С выходом AutoCAD 2010 в формат DWG также были
внесены изменения, поэтому чертежи, по умолчанию сохра-
ненные в AutoCAD 2010, не будут открываться в более ран-
них версиях.

В предыдущих версиях программы размер единично-
го объекта на чертеже не мог превышать 256 Мбайт. В
AutoCAD 2010 этот предел был увеличен до как минимум 4
Гбайт (в зависимости от конфигурации вашей системы).

Для создания нового файла можно применить один из
двух способов:

•  без использования окна начала работы (это наиболее
простой способ, который применяется по умолчанию);

• с заданием различных параметров в окне начала загруз-



 
 
 

ки.
 

Создание нового документа без
использования окна начала работы

 
Для создания нового файла упрощенным способом вы-

полните следующие действия.
1. Щелкните на кнопке New (Новый)

на панели быстрого доступа или выполните команду меню
File → New (Файл → Новый). На экране отобразится диало-
говое окно Select template (Выбор шаблона) (рис. 1.29). Это
окно похоже на стандартное окно выбора файлов операци-
онной системы Windows и отображает содержимое катало-
га Template (Шаблон), принадлежащего директории, в кото-
рую была установлена программа AutoCAD. В данной папке
находятся файлы с расширением DWT, которые представ-
ляют собой готовые шаблоны чертежей, обладающие неко-
торыми настройками и использующиеся как основа для со-
здания документов.



 
 
 

Рис. 1.29. Диалоговое окно Select template (Выбор шаб-
лона)

2. Выделите нужный шаблон. При этом в области Preview
(Образец), расположенной в правой части окна, появится
изображение объектов, которые имеются в выбранном шаб-
лоне.

3. Выберите нужный шаблон и нажмите кнопку Open (От-
крыть).

Примечание
По умолчанию программа AutoCAD

не содержит шаблонов, созданных по



 
 
 

российским стандартам черчения, поэтому при
необходимости следует самостоятельно добавить
файлы нужных шаблонов в каталог Template
(Шаблон).

Если вы не хотите, чтобы в новом чертеже использовал-
ся какой-либо шаблон, нажмите маленькую кнопку со стрел-
кой, расположенную справа от кнопки Open (Открыть). В
открывшемся меню выберите единицы измерения чертежа
(метрические или британские), на основе которых будет со-
здан новый файл (рис.  1.30). Если выбрать в меню пункт
Open (Открыть), файл будет создан на основе выделенного
в данный момент шаблона.

Рис. 1.30. Создание чертежа без шаблона
 

Создание нового документа с
помощью окна начала работы

 
Чтобы при создании нового файла использовалось окно

начала работы, необходимо присвоить значение 1 систем-



 
 
 

ной переменной STARTUP. Для этого выполните следую-
щие действия.

1. Введите в командную строку название переменной и на-
жмите клавишу Enter или Пробел. Появится запрос:

Enter new value for STARTUP <0>:

2. Введите 1 и снова нажмите клавишу Enter или Про-
бел.

3. Щелкните на кнопке New (Новый) на панели быстрого
доступа или выполните команду меню File → New (Файл →
Новый). На экране появится диалоговое окно Create New
Drawing (Создание нового чертежа) (рис. 1.31).



 
 
 

Рис. 1.31. Диалоговое окно Create New Drawing (Созда-
ние нового чертежа)

Рассмотрим основные элементы этого окна.
• Заметьте, первая кнопка – Open a Drawing (Открытие

чертежа) – неактивна.
Выйдите из программы AutoCAD и снова запустите ее.

Теперь при щелчке на кнопке New (Новый) на панели быст-
рого доступа или при выполнении команды File → New
(Файл → Новый) будет открываться окно Startup (Запуск), в
котором кнопка Open a Drawing (Открытие чертежа) будет



 
 
 

активна (рис. 1.32). При нажатии кнопки внутри окна отоб-
разится область Select a File (Выбор файла), позволяющая
выбрать созданный ранее файл и открыть его. Если нужный
файл отсутствует в данной области, вы можете нажать кноп-
ку Browse (Обзор) и в открывшемся окне Select File (Выбор
файла) найти необходимый документ. Это окно очень похо-
же на Select template (Выбор шаблона), описанное выше.

Рис. 1.32. Открытие чертежа

• Вторая кнопка – Start from Scratch (Простейший шаб-
лон) (нажата на рис. 1.31). С ее помощью создается чертеж,



 
 
 

не отличающийся от чертежа, созданного первым способом
(без использования окна начала работы) без выбора шабло-
на.

•  Следующая кнопка – Use a Template (Использовать
шаблон). Создание чертежа идентично созданию нового
файла без использования окна Startup (Запуск). Вы можете
выбрать шаблон документа из имеющихся или отказаться от
шаблонов. При нажатии кнопки Browse (Обзор) откроется
диалоговое окно Select a template file (Выбор файла шабло-
на).

• Последняя кнопка – Use a Wizard (Использовать ма-
стер). Она вызывает мастер создания чертежа, с помощью
которого вы сами можете настроить параметры нового до-
кумента. Мастер может работать в двух режимах: Advanced
Setup (Детальная подготовка) и Quick Setup (Быстрая под-
готовка). При выборе первого способа настраивается боль-
шее количество параметров.

Создадим новый чертеж с помощью мастера детальной
подготовки.

1. В окне Startup (Запуск) нажмем кнопку Use a Wizard
(Использовать мастер), в области Select a Wizard (Выбрать
мастер) выделим пункт Advanced Setup (Детальная подго-
товка) и нажмем кнопку OK (рис. 1.33).



 
 
 

Рис. 1.33. Вызов мастера создания нового чертежа

2. В первом окне мастера (рис. 1.34) предлагается выбрать
единицы измерения чертежа, а также, в раскрывающемся
списке, точность значений (количество знаков после запя-
той). Настроив параметры, нажимаем кнопку Далее.



 
 
 

Рис. 1.34. Выбор единиц измерения

3. Следующее окно позволяет выбрать единицы измере-
ния углов, а также их точность. Снова вводим свои значения
и нажимаем кнопку Далее.

4.  Затем указываем направление нулевого угла. Вы мо-
жете выбрать East (Восток), North (Север), West (Запад),
South (Юг) или указать произвольное значение (отсчет при
этом будет происходить от направления East (Восток)).
Устанавливаем нужные значения и нажимаем кнопку Да-
лее.

5. После этого необходимо задать направление отсчета уг-
лов: против часовой стрелки или в ее направлении. Делаем



 
 
 

свой выбор и нажимаем кнопку Далее.
6. В последнем окне вы можете установить размер обла-

сти, доступной для рисования. Вводим соответствующие па-
раметры и нажимаем кнопку Готово. Чертеж создан.

 
Сохранение и завершение работы

 
Для сохранения документа нажмите кнопку Save (Сохра-

нить) на панели быстрого доступа либо на панели инстру-
ментов Standard (Стандартная). Можно также выполнить
команду меню File → Save (Файл → Сохранить). На экра-
не появится диалоговое окно Save Drawing As (Сохранить
чертеж как) (рис. 1.35).



 
 
 

Рис. 1.35. Окно сохранения чертежа

В нем вы можете выбрать каталог для сохранения, назва-
ние файла, а также его тип: DWG или DXF (тип файлов, ко-
торый можно открыть в других приложениях, а не только в
AutoCAD). При этом вы можете указать версию формата, то
есть, например, сохранить чертеж в формате, совместимом
с ранними версиями программы.

Если вы хотите сохранить файл под другим названием,
щелкните на кнопке меню с буквой «А» в  левом верх-
нем углу окна программы и выполните команду Save As →
AutoCAD Drawing
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